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 1 Allgemeines

Das Skript schildert den Umgang mit Android Studio anhand 
von konkreten Beispielen die unter Umständen auch in den Un-
terricht  im  Fachbereich  Wirtschaftsinformatik  respektive  im 
Fachbereich Informatik einbetten lassen.

Aktuelle Versionen des Skriptes selbst und die im Skript behan-
delten Quellcodes können Sie online herunterladen und testen:

Skript & Sources für die Projekte (für Fortgeschrittene):

 → Alle Arbeitsmaterialien in Chrissis Edublog herunterladen

Für alle Inhalte gilt natürlich das Urheberrecht. Ich selber achte 
auch  darauf.  Um Details  zur  Creative-Commons-Lizenz  für  die 
von mir selbst verfassten Texte und Quellcodes zu erhalten, kli-
cken  Sie  links  auf  das  CC-BY-NC-SA-Logo.  Für  Ergänzungs- 
und/oder Verbesserungsvorschläge schreiben Sie mir bitte eine 
E-Mail: cjanischek@gmx.de 

Weitere Skripte und Sources online:
Einführung in die Programmierung von Android Apps anhand klassischer Unterrichtsbeispiele

Fortgeschrittene Apps mit Android Studio erstellen

Android Apps erstellen

Java Programmieren im Unterricht

Java-E-Learning zum Unterricht

Objektorientierte Sytementwicklung in Java

Dynamische Webseiten mit PHP (objektorientiert) programmieren

Webprogrammierung im Unterricht

Entwickeln mit Javascript Framework (JQuery, JQuery mobile)

Einführung in PHP und die WordPress-Theme-Entwicklung

Relationale Datenbanken
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 2 Installation und Konfiguration der Entwicklungsumgebung

 2.1 Installation

Android Studio download.

Das Android Studio ist aktuell die offizielle Ent-
wicklungsumgebung  für  die  Entwicklung  von 
Anwendungen für mobile Endgeräte mit Andro-
id Betriebssystem.

Die aktuellste Version (für Windows) finden Sie 
zum Download auf den Entwicklerseiten:

https://developer.android.com/studio/index.html 

Es sind auch Versionen für MAC OSX und Linux 
(Ubuntu) zur Verfügung.

Systemvoraussetzungen.

Die Voraussetzungen an das System (für Win-
dows) sind nebenstehend aufgeführt.
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Warum zu Android Studio wechseln?

Für den Fall, dass Sie noch mit Eclipse und den 
entsprechenden Erweiterungen arbeiten, findet 
man zwischenzeitlich auf den Entwicklerseiten 
einen Hinweis:

Darin wird empfohlen, die Entwicklungsumge-
bung  mittelfristig  zu  wechseln,  um  die 
Versorgung mit Updates für die Zukunft sicher-
zustellen.

Installation starten.

Klicken  Sie  die  heruntergeladene  exe-Datei 
doppelt an, um die Installation zu starten.

Setup fortfahren.

Klicken Sie auf die Schaltfläche  Next.→

Die Option Android SDK . 

Der Android SDK enthält je nach Umfang die 
Bibliotheken mit den gerätespezifischen Anga-
ben  für  die  Emulation  der  Geräte  (Handy-
Typen).

Empfehlung:
Den SDK kann bei zu wenig Speicherplatz auch auf 
andere  Partitionen/Datenträger  ausgelagert  wer-
den.  Achten  Sie  darauf  die  System-  und 
Umgebungsvariablen anzupassen (siehe Einstellun-
gen).

Hinweis:
Damit  der  SDK  und  damit  auch  der  Emulator  in 
ganzem Umfang funktionstüchtig sind, benötigt der 
Entwickler auf dem SDK-Verzeichnis die vollständi-
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gen Zugriffsrechte. Gleiches ist für das Programm-
verzeichnis  „Android  Studio“  empfohlen,  soweit 
Updates  durch  den  Entwickler eingespielt  werden 
sollen.

Akzeptieren Sie die  Nutzungsbedingungen für 
den SDK.

Software-Developement-Kit (SDK):
Je  nach  Ausstattung  sind  darin  u.a.  die  für  den 
Emulator notwendigen Softwareerweiterungen ent-
halten die für die Simulation der unterschiedlichen 
mobilen Endgeräte und deren unterschiedlichen Be-
triebssystemversionen  notwendig  sind.  Android 
Studio ist ohne die SDK nicht funktionsfähig!

Akzeptieren Sie die  Nutzungsbedingungen für 
die HAXM.

Hardware Accelerated Execution Manager
Ist eine Software, die im speziellen Intel Prozesso-
ren bei der Emulation von mobilen Endgräten mit 
Android Betriebssystem beschleunigen soll.

Android Studio Installationsort wählen.

Geben Sie hier den Pfad für die Installation des 
Android  Studios  an.  Hier  im  Beispiel  wurde 
dazu im Programmverzeichnis das vorgeschla-
gene Verzeichnis  Android Studio verwendet:→

Variante 1: Lokal
C:\Program Files\Android\Android Studio

Alternative:
Falls gewünscht...

Variante 2: In der Digitalen Tasche
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 G:\Informatikstick2016\Programme\Android\Android Studio→

Laufwerksbuchstaben  können  variieren!  Die  Ent-
wicklungsumgebung ist nur bedingt portable da Sie 
von  den  Hard-  und  Systemvoraussetzungen  des 
Rechners abhängig ist.

Bitte entscheiden Sie sich für eine Variante!

SDK-Pfad angeben. 

Der Installationsassistent schlägt als Installati-
onsort  ein  lokales  benutzerspezifisches  sdk-
Verzeichnis vor.

Variante 1.0: Belassen Sie die Einstellungen.
C:\Users\<Benutzer>\AppData\Local\sdk

Alternative:
Falls gewünscht...

Variante 1.1: Lokales SDK-Verzeichnis:
C:\Program Files\Android\sdk

Variante 2: SDK-Verzeichnis der Digitalen Tasche: 
 G:\Informatikstick2016\Programme\Android\sdk→

Klicken Sie dann auf  Next.→

Hinweis:
Der Ort für das SDK-Verzeichnis kann hier über die 
Schaltfläche  Browse individuell gewählt werden.→

 → Merken Sie sich den Ort unbedingt!
 Sie brauchen Platz! (> 30 GB)→
 Laufwerksbuchstaben können variieren→

Bitte entscheiden Sie sich für eine Variante!
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Startmenü konfigurieren

Erzeugen  Sie  ,  wie  vorgeschlagen,  ein  Pro-
grammstartverzeichnis im Startmenü.

Optional.  HAXM  Arbeitsspeicher  manuell  ver-
kleinern.

Setzen  Sie  den  Arbeitsspeicher  ggf.  manuell 
auf 512 MB. Das ist nur dann sinnvoll,  wenn 
Ihr Rechner gerade einmal die Mindestanforde-
rung  von  2  GB  Arbeitsspeicher  erfüllt.   Für 
Geräte mit hoher Auflösung benötigt der Emu-
lator viel virtuellen Arbeitsspeicher. 

Klicken Sie dann auch die Schaltfläche  Next→

Installation durchführen.

Starten Sie nun die Installation mit einem Klick 
auf die Schaltfläche  Install:→
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Installation abschließen.

Klicken Sie auf  Next.→

Installation abschließen.

Klicken Sie auf  Finish, um die Installation ab→ -
zuschließen.

Nur für den Fall, dass Sie als Administrator kei-
nen Zugang zum Internet haben:

Entfernen  Sie  das  Häkchen   Start  Android→  
Studio.

Klicken Sie auf die Schaltfläche  Finish→

SDK Missing.

Klicken Sie auf die Schaltfläche  Next→
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SDK installieren.

Je nachdem für welchen Ort Sie sich eingangs 
entschieden haben, sollten Sie den Pfad über 
die Schaltfläche  … anpassen.→

Variante1.0: Standard-Einstellung
C:\Users\<Benutzer>\AppData\Local\sdk

Alternative:
Falls anders gewählt...

Variante 1.1: Lokales SDK-Verzeichnis:
C:\Program Files\Android\sdk

Variante 2: SDK-Verzeichnis der Digitalen Tasche: 
 G:\Informatikstick2016\Programme\Android\sdk→

Klicken Sie auf die Schaltfläche  Next→

Bitte entscheiden Sie sich für eine Variante!
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Einstellungen übernehmen.

Klicken Sie auf die Schaltfläche  Finish!→

Installation durchführen.
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Installation abschließen.

Klicken Sie nach Abschluss der Download-Pha-
se auf die Schaltfläche  Finish→

Android Studio öffnen

Sie können Android Studio nun verwenden.
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 2.2 Einstellungen

Android Studio starten.

Variante 1:
Klicken Sie dazu im Menü  Start  Android→ →  
Studio.

Variante 2:
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Android Start Menü: Configure 

Konfigurieren.

Auswahl im Konfigurationsmenü:

Configure Menü: SDK Manager

SDK Manager.

Wählen Sie die Option  SDK Manager→

Aktuelle Kerninstallation

SDK Platforms

SDK Plattforms.

Ergänzen Sie ggf. in Ihrer Auswahl:

Klicken Sie dann die Schaltfläche  Apply.→
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Zeitintensiv!!

SDK Platforms

SDK Tools

SDK Tools.

Wählen Sie ggf. HAXM als zusätzliches Tool aus 
und installieren Sie diese nachträglich.

Schaltfläche  Apply klicken.→
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SDK Update Sites

SDK Update Sites.

Einstellungen belassen.

Schaltfläche  Apply klicken.→

Änderungen bestätigen.

Abschließend mit der Schaltfläche  OK den die→  
Änderungen durchführen.

SDK Lizenzen.

Wählen Sie das Element  android sdk license→  
im Fenster Lizenze aus und markieren Sie die 
die Option  Accept.→

Standalone SDK Manager

Klicken Sie dazu unterhalb des Fensters Set-
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Standalone SDK Manager

Überblick: empfohlener Umfang

ting  Appearance & Behavoir  System Set→ → -
tings   Android  SDK auf  den  Link   Launch→ →  
Standalone SDK Manager.

Prüfen Sie die Liste. Die Bereiche mit dem Ver-
merk  Installed sind bereits  verfügbar.  Falls→  
Sie weitere Bereiche nachinstallieren möchten 
müssen  Sie  das  Häckchen  links  setzen  und 
dann  auf  die  Schaltfläche   Install  packages→  
klicken.

Hinweis:
Die Installation kann je nach Umfang sehr zei-
tintensiv sein.

HAXM Accelerator

HAXM.

Für den Fall dass Sie den Accelerator nachin-
stallieren möchten.

Wählen Sie das Element  Intel x86 Emulator→  
Accelerator, im Fenster Lizenze aus und mar-
kieren Sie die die Option  Accept.→

RAM zuweisen

Meldung HAXM.

Next
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Vorgang abschließen:

Finish

Component Installer

Klicken Sie auf die Schaltfläche  Finish→

Settings

Settings.

Die Settings finden Sie auch in Android Studio 
in der Menü-Leiste File  →

In der Baumstruktur Links finden Sie alle Ein-
stellungsmöglichkeit.

Beispiel:
Unter anderem finden Sie dazu die Settings für 
die Android SDK in der Baumstruktur unter → 
Appearance  &  Behavoir   System Settings  → → 
Android SDK.

Falls Sie hier Änderungen in der Auswahl täti-
gen bestätigen  Änderungen mit   Apply  und→  
schließen das Konfigurationsfenster mit einem 
Klick auf die Schaltfläche  OK.→

Christine Janischek  
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Android SDK

Fertig!
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 2.3 Hinweise

Android Studio download.

Das Android Studio ist aktuell die offizielle Ent-
wicklungsumgebung  für  die  Entwicklung  von 
Anwendungen für mobile Endgeräte mit Andro-
id Betriebssystem.

Die aktuellste Version (für Windows) finden Sie 
zum Download auf den Entwicklerseiten:

https://developer.android.com/studio/index.html 

Es sind auch Versionen für MAC OSX und Linux 
(Ubuntu) zur Verfügung.

Systemvoraussetzungen.

Die Voraussetzungen an das System (für Win-
dows) sind nebenstehend aufgeführt.

Warum zu Android Studio wechseln?

Für den Fall, dass Sie noch mit Eclipse und den 
entsprechenden Erweiterungen arbeiten, findet 
man zwischenzeitlich auf den Entwicklerseiten 
einen Hinweis:
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Darin wird empfohlen, die Entwicklungsumge-
bung  mittelfristig  zu  wechseln,  um  die 
Versorgung mit Updates für die Zukunft sicher-
zustellen.

Getestet auf Computern mit:
1. 64 Bit Intel Core i3 2120 Prozessor
2. Windows 7, 32 Bit Version

Umgebungsvariablen setzen.

Die Benutzervariablen und Systemvariablen für 
die JDK und SDK sollten gesetzt sein.

Die Namen der Umgebungsvariablen sind:
 ANDROID_SDK_HOME→
 JAVA_HOME→

Außerdem müssen diese Ressourcen verfügbar, 
also vorhanden sein.

Wählen Sie dazu die  Option Start   System→ -
steuerung  System und Sicherheit  System.→ →

Erweiterte Systemeinstellungen.

Klicken Sie im linken Frame auf die Option „Er-
weiterte Einstellungen“.
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Umgebungsvariablen.

Klicken Sie auf die Schaltfläche „Umgebungs-
variablen“.

Java Developement Kit (jdk):
Im  Programm-Verzeichnis  befindet  sich  i.d.R.  im 
Unterverzeichnis „Java“ die hier verwendete „jdk“. 
Sie  können  dieses  Verzeichnis  problemlos  an  die 
gewünschte Stelle kopieren.

Hinweis:
Falls Sie eine neuere Version der „jdk“ verwenden 
oder  das  Installationsverzeichnis  variiert  müssen 
Sie den Pfad entsprechend der Realität anpassen.

Der  aktuelle  Java  Developement  Kit  (Java  SE, 
Oracle, Download) können Sie sich auf den Oracle-
Seiten je  nach Betriebssystem auswählen,  herun-
terladen und installieren:

Information über JDK und SDK.

Um die Pfadangaben für die Umgebungsvaria-
blen  (Benutzer-  und Systemvariablen) 
erfolgreich anzugeben müssen die Verzeichnis-
sorte für die „sdk“ und „jdk“ bekannt sein! 

Hinweis:
Sie  haben  im  Installationsprozess  die  Möglichkeit 
die vorgeschlagenen Pfade individuell  anzupassen. 
Merken  Sie  sich  bitte  die  Pfade,  um  die  Umge-
bungsvariablen setzen zu können.

Achtung:
Entscheiden Sie sich für eine Variante!!

Annahme die Pfade sind:
1. Variante 1.0: Standardverzeichnis liegt lokal

 C:\Users\<Benutzer>\AppData\Local\sdk→

2. Oder ein individuelles sdk-Verzeichnis:

Variante 1.1:Lokal: 
 C:\Program Files\Android\sdk→

Variante 2: Digitale Tasche:
 G:\Informatikstick2016\Programme\Android\sdk→

 
3. Das Verzeichnis jdk liegt i. d. R. lokal im 

Programmverzeichnis auf dem Laufwerk 
C:
 C:\Programme\Java\jdk1.8.0_60→

Bitte entscheiden Sie sich für eine Variante!
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http://www.oracle.com/technetwork/java/javase/downloads/inde
x.html 

Neue Benutzervariablen für die SDK setzen.

Variante 1.0: Standard-Verzeichnis
Klicken Sie im Bereich  Benutzervariablen auf→  
die Schaltfläche  Neu und machen Sie folgen→ -
de Angaben:

Angabe:
→ ANDROID_SDK_HOME
→ C:\Users\<Benutzer>\AppData\Local\sdk

Kontrollieren Sie zuvor ob das sdk-Verzeichnis 
einen Unterordner  .android enthält.→

Variante 1.1: Lokal, individuell
Für  den  Fall,  dass  Sie  ein  individuelles  Ver-
zeichnis gewählt haben:

Angabe:
→ ANDROID_SDK_HOME
→ C:\Program Files\Android\sdk

Variante 2: Digitale Tasche
Angabe:
→ ANDROID_SDK_HOME
→ C:\Program Files\Android\sdk
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Neue Systemvariablen  für die SDK setzen.

Variante 1.0: Standard-Verzeichnis

Klicken Sie im Bereich  Systemvariablen auf→  
die Schaltfläche  Neu und machen Sie erneut→  
die folgenden Angaben:

Angabe:
→ ANDROID_SDK_HOME
→ C:\Users\<Benutzer>\AppData\Local\sdk

Variante 1.1: Lokal, individuell
Für  den  Fall,  dass  Sie  ein  individuelles  Ver-
zeichnis gewählt haben:

Angabe:
→ ANDROID_SDK_HOME
→ C:\Program Files\Android\sdk
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Neue  Benutzer-  und Systemvariablen  für  die  
JDK.

Falls  für  die  JDK bisher  keine  Benutzer-  und 
Systemvariablen (JAVA_HOME) vorhanden ist, 
sollten Sie  den Vorgang wiederholen und die 
Benutzer- und Systemvariablen setzen:

Angabe:
→ JAVA_HOME
→ C:\Programme\Java\jdk1.8.0_60

Schließen Sie den Vorgang mit einem Klick auf die 
Schaltfläche  OK ab.→

Beachten Sie:
Je nach Betriebssystem müssen Sie die JDK in der 
32Bit  bzw. 64Bit  Version installieren.  Googeln Sie 
dazu einfach nach den Begriffen  Java SE down→ -
load.

PATH-Variablen setzen.

Über die Schaltfläche   Neu→

hinzufügen.

Variante 1.1.: Lokal, individuell
→ C:\Programme\Android\sdk\tools
→ C:\Programme\Android\sdk\tools\platform-tools

Variante 2: Digitale Tasche
Falls vorhanden...
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G:\Informatikstick2016\Programme\Android\sdk\platform-tools
G:\Informatikstick2016\Programme\Android\sdk\tools

Start Sie Ihren Rechner neu, damit die neu konfigu-
rierten Einstellungen erkannt werden.

Melden Sie sich als normaler Benutzer an und ver-
suchen Sie die Anwendung zu starten.
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 2.4 Fehler

„HAX is not working and emulator runs in 
emulation mode“

HAXM Fehler.

Ein Fehler kann bereits bei der Installation auf-
treten oder aber er tritt auf, wenn erstmals ein 
virtuelles, mobiles Endgerät emuliert wird.

Hinweis:
Dazu muss die  Virtualization Technology bei man→ -
chen neueren Rechner eventuell im Bios aktiviert (→ 
enabled) werden. 

Starten Sie dazu den Rechner neu und wechseln mit 
den Tasten F2, Delete oder ESC ins Bios. 
Im Bereich der CPU/Prozessor-Angaben suchen Sie 
nach Bezeichnungen, wie VT-x, Virtualization Tech-
nology  oder  VT-d.  Diese  Funktionalitäten  müssen 
ggf. aktiviert, also  enabled werden.→

HAXM nachinstallieren.

Öffnen Sie Android Studio und klicken Sie auf  
die Schaltfläche für den   SDK Manager.→

HAXM installer herunterladen.

Normalerweise  erfolgt  die  Installation  von 
HAXM bei der Erstinstallation des Android Stu-
dio zwischenzeitlich automatisch.

Für den Fall, dass das unter Extras aufgeführte 
Paket noch nicht heruntergeladen wurde, kön-
nen  Sie  dies  nun  über  den  SDK-Manager 
nachholen.

Für diesen Fall laden Sie den Sie den fehlenden 
HAXM installer herunter.
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 Das Verzeichnis wird im Ordner „sdk“ abge→ -
legt:

In jedem Fall muss die Installation dieses Pa-
kets  als  Administrator  erfolgen.  Folgen  Sie 
weiter den Angaben.

HAXM-Verzeichnis finden. 

Sie  benötigen  dazu  Administratorenrechte. 
Melden Sie sich deshalb als Administrator an.

Wechseln Sie ins Verzeichnis:
 Programme  sdk  extras  intel → → → →

HAXM installieren.

Öffnen Sie dazu das Verzeichnis:
 Hardware  Accelerated  Execution  Manager→  

und klicken Sie die im Verzeichnis enthaltene 
Datei  „intelhaxm-android.exe“  (Anwendung) 
doppelt an.

HAXM Assistent.

Klicken Sie im ersten Schritt auf die Schaltflä-
che  Next→
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HAXM Arbeitsspeicher manuell verkleinern.

Setzen  Sie  den  Arbeitsspeicher  manuell  auf 
512 MB. Damit stellen Sie sicher, dass Sie rela-
tiv viele Geräte zum testen verwenden können. 

Hinweis:
Für  Anwendungen die  viel  Arbeitsspeicher  benöti-
gen,  kann diese Einstellung eventuell  an Grenzen 
stoßen.  Andere Anwendungen werden langsam.→

Klicken Sie dann auch die Schaltfläche  Next→

Klicken Sie auf die Schaltfläche  Install,  um→  
die Installation durchzuführen.

Warten Sie einen Moment bis die Installation 
durchgeführt wurde.

Klicken Sie Abschließend auf die Schaltfläche → 
Finish

Schließen Sie  die  Intel-Seite  und Starten Sie 
Ihren Rechner erneut.
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 2.5 Top 10 der Hilfestellungen

Maßnahmen bei Anzeigefehlern.

1. Menü-Leiste → Built → Clean Project 

2. Menü-Leiste → Built →  Rebuilt Project

3. Preview Editor → Refresh Rendering → Sync-Button

4. Menü-Leiste → File → Open File → styles.xml → Add the word „Base.“ to the 
beginning of the theme name so that it reads "Base.Theme.AppCompat.-
Light.DarkActionBar"

5. Menü-Leiste → Tools →  Android →  Sync Project with Gradle Files 

6. Menü-Leiste → File → Invalidate Caches / Rebuilt

Maßnahmen bei fehlendem Verständnis:

1. Methode markieren → Menü-Leiste → View → Quick Documantation

Sonstiges:

1. Quellcode einrücken → STRG + A → STRG + I
2. Getter und Setter erzeugen →  Kontext-Menü → Generate → Getters and Setters
3. Methoden Überschreiben → Kontext-Menü → Generate → Override Methods → Methode 

auswählen → Implementierung modifizieren.
4. Methoden generieren (Override/Implement) → ALT + Einfg
5. Import einer Klasse → ALT + ENTER
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